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Blowing Your Tax Refund
by Brent Ozar

Houston Area League of Personal Computer Users

E
very financial planner warns against care-
lessly spending your tax refund as if it’s free
money - but hey, somebody has to be the

devil’s advocate, right? 364 days a year, the humble
author reads Dave Ramsey books, but when that tax
refund comes in, forget it. Get a cart, baby, not one
of those handheld baskets. The only thing more fun
than spending my tax refund is helping spend
somebody else’s.
Rough year, only $100: Logitech QuickCam Orbit

I’ve had the same reliable basic Logitech Quick-
Cam for years as a webcam on my
www.BrentOzar.com site. It works great for video
conferencing with my folks who aren’t so lucky as to
live in Texas. Webcams are webcams — for the most
part, any old $30 model will do the job. The software
makes more of a difference than the hardware.

All that changed when Logitech came out with
the first new webcam to tempt me into spending my
not-so-hard-earned money. At first glance, the Orbit
looks like a futuristic iMac-style version of the
ancient QuickCam, now shrouded in clear plastic.
The difference becomes apparent when you install
the drivers: using basic image processing, the Orbit
tracks your position as you move around - and then
uses its built-in motors to move the camera’s lens to
track you.

Like the Logitech iFeel force feedback mouse I
picked up a couple of years ago, the novelty wears
off quickly. Both devices are better in theory than in
execution: the iFeel’s harsh mechanical motors
always made cheap grating noises, no matter what
settings I used, and the QuickCam Orbit seems to
suffer from the same low-quality materials deci-
sions. The Orbit made louder noises than my two
computers with four CPU fans. Another improve-
ment could be made in the drivers: I’d like to see the
camera track movement regardless of the source so
that I could mount it on my back patio and watch
the squirrels while I work. (Talk about a frivolous
purchase.)
If you’ve got $200 to burn: Tivo

Tivo is a very, very smart and easy-to-use VCR,
but with a computer hard drive instead of changing
tapes. Tivo watches you watching TV, learns what
shows you tend to watch, and automatically records
shows that it thinks you’ll like. It can pause and
rewind live TV without any special setup. With the
Home Media Option, it can even play MP3's stored
on your home computer. DirecTV subscribers get a

special deal: DirecTivos, satellite receivers with
built-in Tivo technology, are available from chain
electronic stores for around $70-$100.

Tivos haven’t caught on quickly because it’s hard
to understand how powerful and easy to use they
are without using it yourself. Stores never have
Tivos on hand hooked up to televisions for demon-
strations, so ask around, find a friend with a Tivo,
and odds are they’ll be more than happy to evange-
lize the Tivo experience. I show it to all of my
friends, and a surprising number have run out and
purchased their own. (And believe me, it’s not
because I’m good at sales.)

If you already have a Tivo, check out the Home
Media Option, but don’t use Tivo’s software. Use
JavaHMO, available at javahmo.sourceforge.net. It’s
a free, open source version that will show local
weather, movies, and even stream Internet radio
like Shoutcast.com direct to your Tivo.
Big spenders with $500 to blow: PDA Phone

After living with an Audiovox Thera for the past
few months, I can vouch for the usefulness of being
able to surf the web from absolutely anywhere - and
not the fake web, either. Those folks at the store
who say people can “surf” on a 1.5" monochrome
screen should be forced to get directions from
MapQuest over that phone: it’s a joke.

On the other hand, surfing with a handheld
PocketPC phone is a relative joy: I’ve been able to
pull sports scores, get directions, and even check the
status of my tax refund while waiting in lines,
relaxing at halftime in arenas, or the ever-popular
Houston pastime, sitting in traffic. Today’s
PocketPC and Palm-based phones can render
normal web sites quite well, albeit with some scroll-
ing involved. Is it worth the $500, though? No - and
that’s why it’s classified as a Tax Refund Special.
Show me the $600-$700! 19" Flat Panel

This represents the ultimate tax-refund pur-
chase - not because of its high price, but because it’s
simply hard to justify spending over $500 on a
monitor when you can get a perfectly good old-style
CRT monitor for half the price. To add insult to
injury, CRT monitors usually offer higher resolu-
tions. But we’re throwing around free money here,
right?

It’s hard to make a bad selection in the 19" LCD
monitor category. Most models here offer 1280 x
1024 resolution, and most offer similar contrast
rates. However, one thing sets the Dell 1901FP
apart from the rest: it rotates 90 degrees, from
landscape to portrait mode. In portrait mode, entire
web pages are visible without scrolling — long pages
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like www.DrudgeReport.com are more readable. The
only drawback is that when the monitor is rotated,
the video signal doesn’t automatically rotate to
match it. The user has to make operating system
changes in order for the display to be flipped. Differ-
ent video cards and operating systems have different
ways of flipping the display: my Nvidia- based card
has an icon residing in the system tray that can
rotate the display with two mouse clicks. Hotkeys
can also be assigned to do this with just a few
keypresses.

From the January 2004 issue of HAL-PC
Magazine. Brent Ozar is a web developer
and network admin. You can have his Dell
19" flat panel when you pry it from his cold
dead fingers. He can be contacted at
brento@brentozar.com. 

DVD Writer
 and Other Stories

by C. Jayaraman
Santa Barbara PC Users Group

I
had just delved impulsively into buying a DVD
writer, (a Sony at that!), we thought why not
write about the trials and tribulations of this

gadget. The model is Sony DRU-510A an AT API
(EIDE) internal drive that was a DVD/CD writer.
What forced me get this was the trouble I had
watching movies with my “Maddog” DVD Player
which kept stopping in the middle of playing a movie
and stop to fill the buffer and go on or just lock up.
I could not troubleshoot this $30 waste of a hard-
ware. 

The Sony replaced both my CD-R/RW and DVD
player freeing up one slot. I had sacrificed my zip
drive to install the Maddog, but now 1 was happy to
restore everything to a semblance of normality. Life
is good — or so I thought. The happiness was short
lived. 

The Sony did a super job of playing all formats
including writing to DVD-R+, DVD- R-, DVD-RW+,
DVD-RW at Ix, 2x, 2.4x, 4x speeds. I was not sure
which format was the best. The CD reader is 32x
and writer is 16x, which are not the best but ade-
quate for most users. The DVD buffer is 8Meg,
which I felt, would solve the freezing problems I had
with the Maddog. I think it did, since I have not had
any issues so far. I have also bought samples of all
different DVD media blanks. They are not cheap.
Even on sale the DVD- ROM costs about $1.50 and
RW about $3 for a 2x. 

I started to quickly learn about archiving (copy-
ing) my movies. Not an economically sound idea

since the time that you spend is more than one
would expect. My first file download was
DVDDecryptor (a free program) that does a super
job of copying the DVD to CAV format files on to the
hard- drive. The Independence Day (1D4) which was
4.77GB filled a cool 7.34 GB on the hard drive since
the original is a dual layer. I played it back and the
result was rather pleasing. I had to play it, a chap-
ter at a time. Now the challenge was to transfer to
another DVD. For this I had to research the web

sites and found DVD-X-Copy was the
coveted one to get. The drawback is
that it will not recompress the files
back from the hard drive. It really
insisted on doing its own decrypting
and insisted on copying on two DVD
blanks. Not a cost-effective solution
since each RW blank cost $6 and I
could buy a previewed copy for $9.

All the media moguls crying about
people copying the movies is real non-
sense. First of all, the DVDs are sup-

posed to last several decades which is far from the
truth. I have seen several failure modes including
layers peeling off the DVD that are bought with
hard earned dollars. I am sure if it happens five
years after purchase no manufacturer is going to
replace it. 

The DVD itself is over-priced to the maximum
extent the public will not complain. A DVD costing
$1.40 to manufacture and market is sold for about
$20. It is reasonable to expect an owner /collector
would want to save the movies in some form. The
analogy is to the good old vinyl records, which lost
their high end of the sound spectrum after about 5
or 6 playbacks. The audiophiles usually copied them
on to tapes and listened to tapes, hopefully preserv-
ing the original for at least a decade. The story from
the consumer is the same regarding DVDs.
I had more than one idea

Back to the story. My other reason was to back
up my hard drive to the DVD. The program
MySonyDVD that was packaged with the drive did
a super, flawless job. However, I forgot that it was
going to go back and verify every file after copying.
Needless to say, this effort took about 4 hours, way
past my bedtime, but I am backed up.

DVDDecryptor and DVD-x-copy decryptor took
about the same time to rip the files from the ID4
disc to hard drive. I researched further and found
the DVDCCOPY express version which is about $50,
and will copy the DVD movie back on to one disc.
Web research shows that the quality suffers slightly
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and may not show up unless you are playing back on
a digital TV, which I don’t possess.

From the January 2004 newsletter of the Santa Barbara
PC Users Group.

Inhuman Computers
by Elizabeth B. Wright

Oklahoma City Personal Computer User Group

O
lder-model automobiles, airplanes and boats
could be cajoled, sweet-talked and occasion-
ally reasoned with. That’s why many people

gave their cars, aircraft and water craft names
(usually women’s names) and made them part of the
family. But that is mostly because they operate by
virtue of the internal combustion engine principle.
(I’m talking about the days before computer chips
replaced some of the mechanical functions of vehicle
operations.). Also cars often take on the personality
of the owner, much like pets do. 

Computers, on the other hand, have no soul, no
compassion, and certainly no desire to please. The
computer is amoral (not immoral, except in the
hands of some people), totally insensitive to invec-
tive or other forms of oral communication, cannot be
humiliated by ridicule or strengthened by praise,
and most certainly doesn’t respond to human rea-
soning. The occasional kick only makes them more
intransigent (and, they break, easily). 

But your computer can sometimes be tricked.
Since they have no sense of humor or sense of
belonging, they do not understand that they can be
replaced easily, usually by a superior, yet cheaper,
machine. So they are not really trying to cooperate
when you succeed in outsmarting them, they just
honestly don’t know any better. 

Computers crash in ways that lead you to believe
there is absolutely no way to recover any of your
most valuable information. But one of the best tricks
of the trade is to just (in the words of a long ago
Oklahoma City weatherman) “turn the d_n thing
off”. Given an overnight rest, many computer
crashes can be mitigated, at least for the short term,
long enough to move your stored data to some other
media, or even to another computer. Along with
giving the machine an overnight rest, it is often
advisable to unplug it from the electrical outlet after
turning it off, to further enhance the rest period. I
am not suggesting that this is an infallible proce-
dure, but I personally have had it help more than
once, and have talked with a lot of other people who
have had similar luck. 

Another trick, and this one is rather obvious, is
to have 

more than one hard drive. Storing your important
documents on both drives helps with recovery should
one drive fail. Again, the computer doesn’t care
whether it has one hard drive or a dozen. As long as
it knows the drives are there, you can pretty much
do your own thing. You wouldn’t necessarily have
two engines in your car, but two or more hard drives
is a good idea. Help is out there to recover your data
if one of the drives is still functioning, even if it isn’t
the boot drive. 

Trick number three: Although the computer
doesn’t tell you so, it does like a cool and hopefully
dust- free environment. It doesn’t know it needs
this, but when it decides to roll over and play dead,
it is often because it is suffering from heat exhaus-
tion. The newer the computer, the hotter it will get
while it is on. Since many people now leave their
machines running 24/7, the heat problem can
become critical. Internal fans are the beginning, but
keeping the computer in a relatively cool part of the
room is also important. Keeping it in the vicinity of
the heat ducts during cold weather is not a good
idea. That just causes the internal cooling equip-
ment to perhaps not be able to handle the job
adequately. 

Trick number four: Dirt and other stuff (bugs for
example) can get into the computer case; it doesn’t
hurt to have someone (who knows how to do it) clean
out the insides of the shell. I don’t advise doing this
if you aren’t really technically adept as those small
parts are so sensitive that you could do a lot more
damage than just leaving it dirty. 

Trick number five: In spile of how you might
think you are communicating with your computer
with fancy screen icons, word commands and pic-
tures, the computer only knows two commands.
They are “on” and “off.” Most of the on/off switches
are in those tiny chips, but the more you can think
in terms of how little the computer actually under-
stands, the more you can see why confusing it with
conflicting programs can overwhelm its ability to
function. More and more of us are wanting to use
the latest and most sophisticated programs on the
market, but just be aware that each new addition
has the potential to cause your computer to become
unstable. Plan ahead! back up your work!

Elizabeth Wright is a member of the OKCPCUG.
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The DealsGuy
by Bob Click

Greater Orlando Computer
 Users Group

M
y wife and I worked the
Lotusphere show held at the Dol-
phin and Swan hotels at Walt

Disney World in Florida this year. There were
between five and six thousand attendees from
around the globe. Talking to attendees, one could
pay as much as $1,600 depending on how many
sessions you attend and how early you registered.
Attendees received an expensive looking back-
pack/carrying bag. It was a three-day show and
much was packed in on the show’s exhibit floor.
There were no large or small booths featuring any
particular vendors, although Lotus was conspicuous
since they were the hosts.

Lotus focused on Workplace 2.0 featuring inte-
gration with Eclipse open source tools and tools
tailored to nonprogrammers. Eclipse offers tools for
improving the ability to pull in the traditional feel of
Notes, also offering drag and drop as well as offline
capabilities. They debuted Workplace Builder, also
included in Eclipse 2.0, offering other tools for
nonprogrammers. They revealed more details of the
Notes Domino version 7 messaging platform, due
out around the end of 2004 or early 2005. There’s
more, but I don’t really understand much of what I
just said. <G>

The show floor was covered with small stands
roughly eight feet tall and seven feet in diameter
with a computer and product sign on each side.
Their term for what I called stands was “pedestal.”
There was room for another exhibitor on each side of
a pedestal, but in most cases that space was for
brochures and give-a-ways. Many products were
Notes and Domino plug-ins.  Even though the show
floor was very busy, there was plenty of room since
all the pedestals were small and offered ample space
for three or four people around a vendor. There were
90 two-station pedestals, 8 three-station pedestals
and 4 five-station pedestals. Also counters with
FREE Starbucks coffee and your favorite cappuc-
cino, which had long lines that sometimes included
my wife or myself.

That arrangement allowed many vendors to
show products in a small exhibit hall. Vendors liked
it because large vendor’s gigantic booths did not
overshadow small companies and everybody had
about the same space to work. I’m sure it was one of
the cheaper shows for exhibitors to show products.
This isn’t computer oriented, but I also found a few

finger foods near the coffee, and some great give-a
-ways at many pedestals around the show, although
I skipped the many free CDs since I am not into
networking, Notes or Domino.

All of the stands and operations were networked
with a very fast connection considerably faster than
a T3 line, and I doubt I would correctly repeat their
explanation to me. The network’s speed was actually
restricted by the outside telephone lines, fast as they
were. The IT guys I talked to had no certifications at
all, but seemed very competent and said they travel
all over setting up networks at trade shows. My wife
and I only worked in the Dolphin Hotel, but to my
knowledge, many of the sessions and some meals
were held at the Swan Hotel with attendees going
back and forth (sometimes in the rain). There was
only 60,000-sq. ft of exhibit space, but 325,000-sq. ft.
of meeting space for the learning sessions. 1,600
people could be served at each meal in the area
where I was checking badges.

I felt few would be interested in a Sun System
for two or three home-PCs, or an IBM high speed
networking system of some kind so I didn’t bother
asking about deals. As a matter of fact, most of the
products were very much over my head so I doubt I
could describe them. I did ask one vendor about
their antivirus products for the home user, but their
marketing person was not there. In fact, my time on
the show floor was limited because I was supposed
to be working the show, not attending it. While IBM
had a presence there, they actually had their own
show about three weeks earlier with exhibits in only
one hall of the Orange County Convention Center in
Orlando, and parts of it also at the Swan and Dol-
phin Hotels at Disney World. We worked the “Super
Show” during those dates so I missed IBM’s show.
The Super Show is an equally interesting large
international sports supply show taking up the
entire 1.6 million sq. ft. of the new convention center
and was very interesting.
Document Delivery Anyone?

I don’t know if you have read about it, but FedEx
is buying Kinko’s. You may wonder what they would
want with Kinko’s? FedEx is in the business of
delivery and perhaps you didn’t realize that so is
Kinko’s. Many business people turn to Kinko’s as a
form of portable business office so many of the
documents handled by Kinko’s are in digital form,
including both incoming and outgoing, meaning
FedEx will expand their document delivery busi-
ness.
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Update On Last Month’s Column
My proofreader said my final release was incor-

rect in the statement about installing Diskeeper on
a Windows Server. Since I am not knowledgeable in
it, please check that out for yourself to get it right if
a server installation is intended. Go to [http://www
.execsoft.com/diskeeper/diskeeper.asp] for more
information about the different versions of Dis-
keeper and the OSs they work with, or to
[http://consumer.execsoft.com/home.asp] for more
information and to order the Diskeeper and Un-
delete bundle at the special price while its still good.
Actually Free For Anyone

I received feedback on last month’s AARP item
saying the volunteer tax service is NOT confined to
just AARP members. I actually knew that but the
volunteers here said they don’t advertise that fact
because they might be overwhelmed. Anyway,
everybody is eligible if your taxes are not too compli-
cated and they want you to know that. One volun-
teer in another city said that volunteers there
sometimes sit around with nothing to do. My apolo-
gies to the AARP volunteers for that misconception.
Check This Deal From MediaFour

I think all user groups received this special offer
announcement from Sue Nail, PR Director for
MediaFour. I’ll include it here for my readers using
her words:

“XPlay is the smart way to use your Apple iPod
with Windows. XPlay brings the power of the ulti-
mate MP3 player to Windows users. Just plug your
Apple iPod into your Windows computer, and XPlay
makes it easy to load your MP3 music and other
files. $29.95 Downloadable version $39.90 Physical
copy 

“MacDrive for PC users – MacDrive 5 is the best
way to use Mac disks with Windows. MacDrive
software makes Mac disks act like normal PC disks,
so it’s a great way to get files both from Macs to PCs
and from PCs to Macs. MacDrive wins its awards for
simplicity as well as power! $49.95 Downloadable
version $59.95 Physical copy 

“Contact me for the special user group offer!!!
Sue Nail. <suenail@cableone.net> [www.mediafour
.com] Phone 605.235.1991"

The deadline for this offer is June 1, 2004 and I
thank Sue for allowing the DealsGuy column to
publish it.
Can That Spam!

Aladdin Software announced a special offer for
users groups on SpamCatcher that they claim blocks
99% of the spam. Since these announcements often
go only to designated officers in a user group who

are usually very busy people, it doesn’t always get
passed on to the members, or if you missed the
meeting it was announced at, you now know about
this deal. I posted it on my Web site so I suggest you
take a look at the posting on my announcements
/Aladdin page. [http://www.dealsguy.com] Using
their order form lets you purchase SpamCatcher
(MSRP $29.99) at 40% off for just $17.95 + S&H.
[http://www.aladdinsys.com /store] Remember to
enter the code “User Group” (exactly as shown) in
the “discount code” field. A 40% discount will be
given when you hit “apply.”

Also posted in that announcement is Spring
Cleaning 3.0 (MSRP $29.99) for 40% off at $17.95 +
S&H. which is a great saving. Check their Web site
if you want more description. I have not tried either
product myself so I cannot speak from experience on
how it works.

That’s it for this month. Meet me here again
next month if your editor permits. This column is
written to make user group members aware of
special offers or freebies I have found or arranged,
and my comments should not be interpreted to
encourage, or discourage, the purchase of any
products, no matter how enthused I might sound. 

Bob (The Cheapskate) Click [Bobclick
@mindspring.com]. Visit my Web site at
[http://www.dealsguy .com] for past columns and
many interesting articles I have taken from various
users group newsletters.

A Novice’s Struggle
 with CD-RW Drives

by Merrill Friend
Tampa PC Users Group

S
ome time ago I purchased a Buslink Ultra-
high speed CD-RW external drive for a laptop
which had only a CD Rom drive. The Ultra

High Speed unit has a maximum write speed of 52X,
which is plenty fast. Then I got some Ultra high
speed CD-RW Memorex discs and I was in business.
After installing the drive, which connected using a
2.0 USB port, all worked fine. I could easily record,
erase and record again on those fabulous Memorex
discs. I could select various record speeds, and all I
tried seemed to work effortlessly. I also got some
Sony high speed CD-R 700MB discs, which also
worked fine and were considerably cheaper. This
external drive was supported by Nero software. I
was happy.

Later I purchased a new Gateway laptop com-
puter with a built in CD-RW drive with Roxio
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software installed. Since everything had worked so
well with the Buslink external drive I expected that
I would have the same wonderful and smooth
experiences with the Gateway drive. I should never
have been so naïve.

I tried my Memorex ultra high speed CD-RW
discs in the Gateway computer and got a message
from Roxio that I had not installed proper media in
the drive and should immediately place a blank
CD-RW disc in the drive. I tried one Memorex after
the other in the drive and got the same message on
all of them. I then tried the Sony CD-R discs which
the drive did recognize and I was allowed to burn a
CD-R disc.

Next, I went to Roxio’s home page at Roxio.com.
The first thing I needed there was the identification
of the specific version of Roxio Software I was using
and the serial number of the product. I was told that
I could get that information by opening the Roxio
program and then clicking on “HELP” where I could
see the software version as well as the serial num-
ber. Well, I got the software version but no serial
number. I was to learn later that this was because
the Roxio software came installed on my computer,
and I didn’t have a separate Roxio disc with a serial
number. Without a serial number I couldn’t get
technical support from Roxio. I had learned the
software version was 5.3.5.10. I then called Gateway
and they said it was Roxio’s problem. Now why
wasn’t I surprised to hear that?

I ended up joining the Roxio online discussion
group where a serial number is not needed. I soon
learned I did need one more bit of information. I
needed specific details on the type of CD-RW drive
that was installed in my machine. I went to “My
Computer”, clicked on the CD-RW drive and selected
properties and learned that I had a QSI CDRW/DVD
242U drive. Armed with all this data I was able to
fully delineate my problem to the discussion group.
Within a few hours I had one very good and helpful
response.

The respondent indicated that he had researched
my drive somewhere and learned that the RW
rating for that drive is 10X Maximum. Thus it would
be unable to read my Ultra High Speed Memorex
discs. He then advised me that there are three speed
groups for RW drives. Per this person, the speed
categories are as follows:

• Low Speed, which is from 1x to 4x
• High Speed, which is from 4x to 12x
• Ultra High Speed, which is from 12x to 24x
He also added that Memorex discs are the most

problematical for use with various machines and

software, although they had worked perfectly with
the external Buslink Ultra High Speed drive previ-
ously. I was advised by the writer that he had also
had difficulties with Memorex discs of the correct
speed range and had changed to Verbatim discs of
650MB size suggesting that the 700MB size of the
Memorex may have also been a factor. He stated
that the Verbatim drives worked fine.

I began shopping around for different brands of
CD-RW discs. I didn’t find any Verbatim discs, but
I did locate some “High Speed” Maxell discs at Office
Depot so I bought a small package of them. These
discs were recognized by my laptop, but my machine
indicated it would only read and write to this disc at
a 4x speed. No other speeds were available on my
machine. I tried writing to them and they worked
satisfactorily although slower than I had antici-
pated. I was also able to erase material satisfacto-
rily. So now I at least had a working CD-RW drive,
albeit a slow one.

After all this difficulty, I began to wonder just
why CD-RW drives are needed? Why not just a
CD-R? Wouldn’t that do just as well? All the new
machines seem to be coming out with CD-RW
drives, so naturally I wanted to have the latest most
modern drive but what exactly can I do with it? I
looked through the stock of CompUSA and had
difficulty locating any CD-RW discs except for those
Memorex discs mentioned earlier. Yet there were
literally tons of CD-R discs of various manufactur-
ers. That should have told me something. The
CD-R’s were also much less expensive and available
in large packages at a discount.

For my purposes I felt the CD-RW would be
helpful in making up discs to save and organize
material which I might reorganize or make minor
changes to from time to time until the project was
finalized. Then when I had the material in its final
state, I could put it all on one CD-R disc as a perma-
nent record. Now I am beginning to feel that the cost
of the CD-RW discs plus these slower speeds may
not be worth the effort. Also, I may end up owning
five different brands of CD-RW discs in order to find
one or two that will work well with my equipment.

Perhaps I might just as well make a CD-R disc
and redo it as needed in its entirety and throw the
previous ones in the trash as the new ones are
made. Perhaps that will work just as well.

I may have one other option. That would be to
install the Buslink external CD-RW Ultra High
Speed drive to this laptop and use it for all my
serious CD-RW work. The question I am struggling
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with is will this cause a conflict with my Roxio
software for the factory installed CD-RW drive.

I suspect it should not since the Nero software
for the Buslink external drive is designed to work
only with that external drive (per instructions on the
box). The Roxio software would continue to be used
for the originally installed drive. If anyone has any
other thoughts on that please let me hear from you.

From the March 2004 issue of Bits of Blue, newsletter of
the Tampa PC Users Group.

Simplified File Format
 Choices for Digital Images 

by Alex Dumestre
1960 Personal Computer User Group

N
ewcomers to digital photography (or to digital
imaging in general) frequently ask me what
file formats they should use. If one opens the

“Save As” dialog box in a graphics editing program
a list of many different formats appears (41 in
PaintShop Pro v8 for example)! Which one should I
use? 

Just use the simple rules that I present here
until such time as you learn enough about the
subject to make your own informed choice to do
something different. 

There is no single format that is ideal for all
types of images in all uses. 
Image types: 
• Photo Realistic: As the name implies, these are

photographs as we usually think of them —
people, parties, houses, cities, landscapes —  the
usual subject of snapshots. 

• Other graphics: Just about any graphic image
that is not a typical photograph.
The identifying characteristic of photo-realistic

is that the colors or shades of gray very smoothly
through many, many subtle differences whereas
other graphics generally use only a few colors or
tones. Examples of these are: Logos, Posters (think
Toulouse Lautrec), Drawings, Web page buttons,
Maps, Water colors and paintings (though some of
these can get into the photo-realistic category).
Uses:
• Screen display: Computer screens tolerate low

resolution pictures because computer screens are
relatively low resolution devices. Images that are
intended only for display on your computer
screen or, by way of e-mail or “Web pages, for
display on other people’s computer screen can be
treated in a special way.

• Printed: Images to be printed typically demand
higher resolution (unless the printed images are
to be very small).
With these definitions behind us, let’s look at

these tables:
What Format Should I Use?

Format Considerations 
• All graphic formats provide for storing the color

(or grayscale) information for each pixel in the
image. That is basic.

• All graphic formats also provide for recording
some other essential or useful information but
this differs widely among the various formats.
Examples of this auxiliary information are:
Transparency, Animation, EXIF, Layers, Masks,
Print Size, Pallets, Alpha Channels, etc.

• Some graphic formats attempt to reduce the size
of the file compared to its “natural” size, i.e.,
compress it.

• Some graphic formats are limited in the color
depth (the number of distinct colors or shades)
they support. 
Let me make some comments about a couple of

relatively new formats that will probably become
much more prominent in the future. 
1.   PNG (pronounced ping) was designed several
years ago primarily to overcome some shortcomings
of the GIF format while retaining most of its
strengths. A potential problem with GIF is that its
compression technique is patented and software that
writes it could possibly be sued or charged a license
fee by the patent holder (CompuServe). Also, it was
a rather ad hoc development without all of the usual
discussions and compromises that are typical of a
standard-defining organization. PNG retains a
lossless compression and transparency while allow-
ing 24 bit color depth. The best of both worlds. It is
supported by the top tier browsers but has not
caught on very well with Web writers. 

UseUse TypeType

ResolutionResolution PhotoPhoto
RealisticRealistic

OtherOther
GraphicsGraphics

ScreenScreen
Display OnlyDisplay Only

72 ppi JPEG GIF (or PNG)

PrinterPrinter 200 ppi JPEG GIF (or PNG)

Before finalBefore final
editedit

As above TIFF or
editor’s own

GIF (or PNG)
or editor’s
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2.   JPEG 2000 (or JP2) was introduced a year or
two ago as a successor to JPEG. It has some wonder-
ful abilities, particularly its compression. Its major
disadvantage is that the compression technique is
computa-tionally heavy and I suspect that this is the
main reason that it has not caught on with digital
camera manufactures. This has slowed its accep-
tance in general. Whereas JPEG files at moderately
high quality settings can be on 5 to 10% as large as
the original image, JP2 files of the same quality can
be as little as 1% or less as large as the original
image. 

With the above considerations in mind, let’s take
a look at a few distinguishing characteristics of a
few of the most used formats.
• Color Depth (it takes 1 byte per pixel to store the

color code when the color depth is 256 but 3
bytes per pixel when the color depth is 16 mil-
lion), 

• Compression type and quality.
• Even the subject of the picture influences how

much the compression shrinks each picture. 

File For-
mat

File Op-
tions

B&W
Text 600

x 450

Photo
1280 x
960

Photo 640
x 480

TIFFTIFF – 163 KB 1.8 MB 608 KB

JPEGJPEG 99 quality

85 quality

70 quality

149 KB

68 KB

44 KB

675 KB

225 KB

80 KB

–
48 KB

–

GIFGIF 256 colors

16 colors

31 KB

21 KB

601 KB
–

171 KB
–

PNGPNG 16 mil-lion
colors

256 colors

2 colors

55 KB

36 KB

10 KB

2.1 MB

612 KB
–

564 KB

176 KB
–

PSPPSP – 259 KB 2.62 KB 725 KB

From the March 2004 issue of PC News, newsletter of the
1960 PC Users Group of Houston Texas.

Computer Memory
by Brian K. Lewis, Ph.D.

Sarasota Personal Computer Users Group, Inc.

O
ccasionally the question arises as to how
much memory can be put in a computer. The
answer is “it depends.” It depends on just

what you mean by memory (RAM or hard disk),
what operating system you are using and the capa-
bilities of your computer’s motherboard and its
chipset. When I talk about memory I am not refer-

ring to the permanent storage of programs and data
on the hard disk. Rather, I refer to the random-
access memory or RAM. This is the memory provided
by memory chips seated in slots on the motherboard
of today’s computers. Anything stored in RAM
disappears when the power is turned off, so it is
referred to as volatile, or temporary, memory.

If you want to upgrade the memory in your
computer you have to be able to determine the
memory type as well as the size, pins and speed, the
number of slots available on your motherboard and
the maximum amount of memory that your system
can address. In general, this varies with the age of
your computer. So let’s look at these components in
a little more detail. (Please note that although my
remarks refer to Intel’s Pentium series central
processors, they also generally apply to the equiva-
lent AMD processors.)

Early Pentium based computers had a CPU bus
speed of 66 MHz (megahertz) and a PCI I/O bus
speed of 33 MHz. These values relate to the speed of
data movement within the central processor and
transmission to and from peripherals such as the
memory bank. In some cases transfer to and from
memory was at 50 MHz. Pentium computers gener-
ally had four slots which were arranged as two
banks. This meant that memory had to be installed
in units of two. The memory chips were 72 pin
DRAM (dynamic RAM) or SIMM (single in-line
memory modules) modules. Many of these computers
could support four DRAM modules of 32 MB (mega-
bytes) for a maximum of 128 MB of RAM. There
were some motherboards built for Pentium 5 sys-
tems that had 2 or 3-168 bit DIMM slots in addition
to the 72 pin slots. However, you could not use both
the 72 pin and 168 pin slots, only one or the other.
These systems would support either 128 or 256 MB
of memory. However, at the time, many Pentium
/Pentium II computers were sold with only 16 MB of
RAM and Windows 95. Later, with Windows 98 the
basic memory was 32 MB. In both cases, this is a
less than optimum amount of memory for these
operating systems. The first Pentium computers had
a 32 bit address space which was theoretically
capable of addressing 4 GB (gigabytes) of memory.
However, none of the motherboards manufactured
for these computers carried any such memory capac-
ity.

The next generation of computers carried faster
CPUs and chipsets along with faster bus speeds. For
example the Intel 440 series chipsets were capable of
working with CPUs with speed of 233 - 333 MHz at
a bus speed of 66 MHz or with 350-450 MHz proces-
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sors at a bus speed of 100 MHz. These motherboards
generally had 3-168 pin slots and would support a
maximum of 384 MB of RAM. As the address space
of the CPU was increased to 36 bit, the maximum
addressable memory was 64 GB. However, in
practice some computers running Win98 would not
recognize more than 256 or 384 MB of RAM. This
problem has been ascribed to the chipset design and
problem with the L-2 cache. So some caution is
recommended if you intend to upgrade the memory
in a Pentium II or older system With some of the
Pentium III class computers there was an additional
increment in bus speed to 133 MHz. The mother-
boards had 2 to 4 168-pin memory slots. The maxi-
mum usable memory of such systems ranges from
512 MB to 1 GB. These motherboards for this CPU
class are generally able to use 100-133 MHz
DIMMs. The 133 MHz DIMMS are capable of
working at the 100 MHz speed. The Pentium 4
motherboards came with a whole new array of
chipsets and memory chip types and speeds. The
maximum memory now ranges up to 4 GB. Intel’s
initial Pentium 4 motherboards required the use of
RDRAM or Rambus DRAM memory chips. RDRAM
is a serial memory technology that arrived in three
speeds, PC600, PC700, and PC800. RDRAM designs
with multiple channels, such as those in Pentium 4
motherboards, are currently the fastest in memory
throughput, especially when paired with the newer
PC1066 RDRAM memory. A Rambus channel is 2-
bytes wide, so we get a maximum 1.6GB/s transfer
rate for a single RDRAM channel using PC800
RDRAM or 2.1GB/s for PC1066. The other form of
memory chip is the double data rate DRAM. Intel
and other manufacturers now have motherboards
and chipsets that can utilize these memory modules.
They are less expensive than the RDRAM. DDR
memory modules are named after their peak band-
width — the maximum amount of data they can
deliver per second — rather than their clock rates.
This is calculated by multiplying the amount of data
a module can send at once (called the data path or
bandwidth) by the speed of the front side bus (FSB).
The bandwidth is measured in bits, and the FSB in
MHz. Note that the RDRAM bandwidth is in bytes.
One byte is equal to 8 bits.

A PC1600 DDR memory module can deliver
bandwidth of 1600Mbps. PC2100 (the DDR version
of PC133 SDRAM) has a bandwidth of 2100Mbps.
PC2700 modules use DDR333 chips to deliver
2700Mbps of bandwidth and PC3200 — the fastest
widely used form in late 2003 uses DDR400 chips to
deliver 3200Mbps (3.2 Gbps) of bandwidth. You may

see the term “dual channel” applied to memory.
When properly used, the term refers to a DDR moth-
erboard’s chipset that’s designed with two memory
channels instead of one. The two channels handle
memory-processing more efficiently by utilizing the
theoretical bandwidth of the two modules, thus
reducing system latencies, the timing delays that
inherently occur with one memory module. For
example, one controller reads and writes data while
the second controller prepares for the next access,
hence, eliminating the reset and setup delays that
occur before one memory module can begin the
read/write process all over again.

Consider a model in which data is filled into a
container (memory), which then directs the data to
the CPU. Singlechannel memory would feed the data
to the processor via a single pathway at a maximum
rate of 64 bits at a time. Dualchannel memory, on
the other hand, utilizes two pathways, thereby
having the capability to deliver data twice as fast or
up to 128 bits at a time. The process works the same
way when data is transferred from the processor by
reversing the flow of data. A “memory controller”
chip is responsible for handling all data transfers
involving the memory modules and the processor.
This controls the flow of data through the pathways,
preventing them from being over-filled with data.
Now that you are totally confused by all this memory
type and speed terminology, let’s look at the next
question.

How much memory should you have in your
computer? The answer is: probably as much as your
motherboard and chipset can handle. For the newest
motherboards, that may be excessive unless you are
involved in digital video editing or graphic design.
For most home users running WinXP or Win2K I
would recommend 512MB up to 1GB. So why those
figures? I have found that WinXP uses over 200 MB
of RAM for its own files, if that much is available. So
on a 256 MB system that leaves very little for other
applications and data. The net result is a lot of
swapping with the virtual memory space on the hard
drive. That slows everything down. In WinXP the
Windows Task Manager (bring up by pressing
CTRLALT-DEL) shows your current performance
and the amount of memory available in real time.
With 512 MB and several programs running, I have
over 300 MB of real RAM available. That greatly
increases the responsiveness (speed) of the system as
moving data to and from RAM is many times faster
than using a hard disk. The Page File window shows
you the virtual memory swapping your system is
doing. At the moment, mine is zero.
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You can do similar analyses on Win98 /WinMe
systems. The System Monitor application that comes
with Windows can supply this information.

However, you may need to modify it to get the
memory info you want. Go to Start-Programs-
Accessories-System Tools and select System Moni-
tor. If this selection is not available on your menu,
then you need to install the program from your
original Windows disk or from \WindowsOptions
\Cabs file. You do that from the Control Panel (Add/
Remove Software) and Windows Setup. Once you
have the system monitor you can ADD memory
information by clicking on Edit, then add item.
Select Memory Manager. The individual items that
will be the most helpful are: allocated memory,
unused physical memory, page files in/ out, swapfile
in use or swappable memory. The kernel reading
tells you how much of your CPU capacity is being
used. Generally, Win98 /WinME will do very well
with 256 MB — 384 MB of RAM. You just have to be
certain that your motherboard and chipset can
support this much RAM. Most of the home comput-
ers I have worked on really don’t have enough RAM
for the most efficient operation. Does Yours?

Dr. Lewis is a former university & medical school profes-
sor. He has been working with personal computers for more
than thirty years. The Editorial Committee of the Association
of Personal Computer User Groups (APCUG), an international
organization of which this group is a member, brings this
article to you.

Hi! I’m from the
 Government and I’m Here

 to Help Your Computer
by Ira Wilsker

O
ur computers are apolitical inanimate ma-
chines not influenced by our personal politics.
While we as individuals may differ in our

beliefs of how much the government should be
involved in our personal computing, there is an
increasing amount of influence government agencies
are having in our routine computer utilization.

Recently the U.S. Department of Homeland
Security, acknowledging the role that our personal
computers have in national security, announced a
series of email alert services to notify us of potential
cyber attacks and other threats to our cyber infra-
structure.  As has been explained previously in this
column, our computers and net access have become
a potential target of terrorism, and can be utilized to
launch cyber attacks without our knowledge. As I
type this, the Utah based software company SCO,
has had its net access shut down because it was one

of the targets of a denial of service attack launched
from countless thousands of computers infected with
the “A” version of the MyDoom worm. 

The free alert system from the Department of
Homeland Security, coincidently announced as the
MyDoom worm infected millions of machines and
slowed down the net, is available both online and by
email subscription at www.us-cert.gov. Warnings
will be posted on this site, and e-mailed to subscrib-
ers as soon as they are released. The free email
alerts are listed at www.us-cert.gov/cas/index.html
and distributed in four varieties. Two of the alerts
are highly technical versions, and two are non-
technical “plain English” versions. If you decide to
subscribe to these free alerts, be sure to follow the
subscription instructions explicitly. In order to
prevent the unauthorized “spamming” of subscrip-
tions, a double opt-in process is utilized. When you
send the initial email subscription, a confirming
email will be sent by the email list server containing
a unique reply code; be sure to follow the instruc-
tions exactly in that reply email in order to effect the
subscription.

The “Technical Cyber Security Alerts”, as listed
on the US-CERT.GOV website, “…provide timely
information about current security issues, vulnera-
bilities, and exploits.” The other technical alert is
“Cyber Security Bulletins” which “…provide bi-
weekly summaries of security issues and new vulner-
abilities. They also provide patches, work-arounds,
and other actions to help mitigate risk.”

For those interested in less technical, but other-
wise current and helpful information, a pair of non-
technical alerts is available. One is “Cyber Security
Alerts” self-described as, “…provide(s) timely infor-
mation about current security issues, vulnerabilities,
and exploits … that affects the general public. …
(and) outline(s) the steps and actions that non-
technical home and corporate computer users can
take to protect themselves from attack.” The other
non-technical alert is “Cyber Security Tips” which
“…describe(s) common security issues and offer
advice for non-technical home and corporate com-
puter users.”

These alerts will contain a verifiable electronic
signature to ensure that they are really valid alerts,
and not some misleading spam intended to spoof
authentic alerts and mislead victims. Despite such
precautions, there has been some concern that these
alerts can still be falsified, leading to the type of
damage that they are intended to warn about. In a
recent statement released by Senator Charles
Schumer (D-NY), “If I were a betting man, I’d put a
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few dollars down that the next virus that clogs
computer networks is going to be transmitted
through an e-mail that looks like one of these DHS
e-mail alerts.” 

All four of these alerts, as well as the concurrent
information posted on the US-CERT.GOV website,
are intended to supplement, not replace, similar
alerts already distributed by such cyber security
companies as Symantec (Norton), Network Associ-
ates (McAfee), Panda, Sophos, F-Secure, Trend, and
other publishers of antivirus, firewall, and Internet
security software and services.

In a less fearsome mode, there is a helpful
service available from the quasi-governmental
agency, the U.S. Postal Service, to assist businesses,
organizations, and individuals who mail items using
“Priority” or “Express” mail. Small quantity users
can use a free online service “Click-N-Ship” available
at www.usps.com to generate and print mailing
labels, complete with tracking number bar codes.
Larger volume users of Express and Priority mail
can download a free utility, “USPS Shipping Assis-
tant Software” from the Postal Service to generate
mailing labels on their own computers. Available for
f r e e  d o w n l o a d  f r o m  w w w . u s p s . c o m
/shippingassistant, this interesting utility can be
used to track and confirm deliveries, verify zip codes,
create mailing labels, calculate domestic and inter-
national postage, calculate delivery times, create
and store address books, and even generate mer-
chandise return labels. The labels themselves,
complete with barcodes for tracking, are typically
printed one or two to an 8.5 x 11 sheet of self-adhe-
sive labels. Labels are available from the Postal
Service website from a private contractor, our local
office supply stores, or online. I recently used both
the free online label service, and the “USPS Ship-
ping Assistant 2.2“ I recently downloaded to prepare
labels to mail merchandise to my kids.  I found both
were easy to use and produced excellent quality
labels on my printer. I then used both the free online
tracking on the USPS.COM website and the online
tracking service integral with the Shipping Assis-
tant software to track the packages, and both
worked equally well.

Now that computers have become a ubiquitous
part of our daily lives, it is inevitable that we will
see more governmental involvement and assistance
with our daily computing.

Ira Wilsker is the Advisor for Region 8, APCUG Represen-
tative & Bylaws Chair for the Golden Triangle PC Club, a
columnist for The Examiner in Beaumont, Texas, and has two
radio shows. He also graciously shares his articles with the
APCUG editors.  

There is no restriction against any non-profit group using
this article as long as it is kept in context with proper credit
given the author. The Editorial Committee of the Association of
Personal Computer User Groups (APCUG), an international
organization of which this group is a member, brings this
article to you.

Accessibility for Everyone
by Billy Mabray

Oklahoma City PC Users Group

M
any people, including a lot of Web designers,
think Web-site accessibility is only about
making sites work for blind users with

screen reader software. Accessibility should be about
all of us. There is a wide range of physical conditions
that can make using the Web difficult. The Internet
can be a frustrating place when you have poor
eyesight, color blindness, or trouble using a mouse.
You may not fall into any of these categories right
now, but consider this statistic: 100% of Internet
users are growing older. At some point, we will all
need help navigating the Web.

There are many things that can be done to make
the Web more accessible. Some of those things are
already built into your Web browser. Others require
Web designers to implement accessible features on
their Web sites. If you are one of the many people
who has difficulty using the Web, you will want to
know what help is out there.

One of the biggest complaints people have is that
text is too small. It is also the easiest to remedy. If
you are using Internet Explorer, choose View>Text
Size from the top menu. Also, if your mouse has a
scroll wheel, you can hold the CTRL key and scroll
up and down to change the text size. Now, this will
not work on all Web pages — later, we will discuss
why that is and what Web designers can do about it.
The Netscape/Mozilla browser, however, can change
text size on all Web pages. Choose View>Increase
Text Size, or hold CTRL and press the + key.

There are many shortcut keys available for those
who have difficulty using a mouse. For example, the
backspace key will take you to the previous page, F5
will reload your current page, and ALT plus the
Home key will take you to your home page (the page
set to load when you open your browser). Also, if you
have gone back to a previous page, ALT plus the
right arrow will take you forward again. Another
useful key on any Web page is the TAB key. You can
use the TAB key (and SHIFT plus TAB to go in
reverse) to quickly navigate forward through all the
links and form fields on a Web page. Once you have
tabbed to a form element, other keyboard shortcuts
may come in handy. For drop-down boxes, you can
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use the up and down arrows to highlight your
selection.  For radio buttons or check boxes, use the
space bar to select your choice. If you are using a
recent version of Netscape/Mozilla, you can also use
“Find As You Type.” Start typing at any page and it
will automatically do a search for what you are
typing on that page.

Some people, particularly the color blind, find
Web sites hard to use because the color of the text
does not contrast enough with the background
colors. If the color scheme of your favorite Web site
makes it difficult to read, you can override that as
well. You will find this under Tools->Options or
Edit->Preferences, depending on your browser. You
can set your default fonts, font sizes, and page
colors. You can also specify that your defaults
always override what is set by the Web page.

While these browser features can be helpful,
there is still much Web designers must do to make
their site accessible to the widest possible audience.
A good example is text sizing. If Web designers use
fixed text sizes — sizes that specify an absolute unit
of measurement, such as points or pixels — on their
pages, Internet Explorer users cannot change their
text size as I described earlier. Web designers can,
and should, use relative text sizes to make their
pages more accessible. Designers who prefer to use
absolute sizes for text should provide a “style
switcher.” This is a link on the page that allows the
site’s visitor to make the text bigger and saves that
preference in a cookie.
Another accessibility feature that some designers
use is access keys. These are just like the shortcut
keys I mentioned earlier; except they are defined by
the Web page you are on. For example, the designer
could define ALT plus 4 to take you directly to the
search function. If you visit a site regularly and
know their access keys, they can be useful.

Web designers should also use labels for forms.
Labels make the text next to a form field clickable,
just like the field itself. For example, if a form has a
check box that reads, “Click here to subscribe,” and
that text is set as a label, the user can click any-
where on that text to check the box. It can be very
helpful to have a larger target when trying to click
things with a mouse.

We still have a long way to go before the Web is
accessible to everyone. But now you know some of
the helpful features you have at your fingertips
already, and you know what to ask for from the Web
sites you frequent. Hopefully, as users learn what
they can do, and designers learn what they need to
do, we can all enjoy the Web a little more.  

Billy Mabray and his wife, Angela, own Smart Goat, a local
software development and web design business.  They are
members of the OKCPCUG. Comments or questions on the
article are welcome and can be addressed to: billy
@smartgoat.com. The Editorial Committee of the Association of
Personal Computer User Groups (APCUG), an international
organization of which this group is a member, brings this
article to you.

Do You Need
 a New Computer?

Well, maybe . . . or maybe not
by Dr. Roland B. Herman

Westchester PC Users Group

C
omputer technology keeps changing. Both the
hardware and the software are continually
undergoing improvements, upgrades, revi-
sions, patches, and new items and completely

new original projects are added.
CD-RW

Here is just one example. Practically every new
computer today comes with a built-in CD-R/RW
drive. This is hardware and software that permits
making copies of CDs, and using CDs to make
back-ups and store data the way floppy diskettes
and ZIP disks have been used. However, a typical
CD for this use has a capacity of about 600 mega-
bytes, which is hundreds of times more capability
than a floppy diskette and about three times greater
than the larger ZIP disks. Also, the larger ZIP disks
cost about $15 each, whereas a CD-R costs about
thirty cents and a CD-RW costs about 90 cents. The
CD is more durable and the data will last much
longer than on a floppy or ZIP disk.

That is just one example, but there are many
many more changes for just about every conceivable
computer use in the home and in industry. There are
changes for networks, Internet use, voice recogni-
tion, DVDs, audio, video, wireless accessories,
keyboards, mice, monitors, laptops, palms, digital
photography, etc. There is improved and faster RAM,
and faster CPUs and motherboards. I could go on
and on, but I think you get the idea.

Ok, so do you need a new computer? Well, the
computer industry suggests that a typical computer
will become obsolete after a period of about three
years. Does that mean that you should buy a new
computer every three years? Well, maybe... or maybe
not. It depends upon what you now use the computer
for and if you are satisfied with its performance, and
what you plan to use it for in the future.

For example, suppose that you only use the
computer with its Word processing software for
writing letters and documents, and printing them
out and mailing them via the Post Office. You would
be using the computer as an old fashioned type-
writer. I have several friends that do just that. In
some cases, they don’t even Save their work. As long
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as the computer and the printer work, they are
happy.

Why would these people need a new computer
after a number of years? They would not. Unless
they upgraded their use or interest, their computer
could be usable for many years. Some of them are
using old 486 computers with Windows 3.1 as the
operating system and Microsoft Word version 6 or
earlier as the software. They don't use color, graph-
ics, or different fonts in their documents. They are
not interested in the Internet, e-mail, games,
spreadsheets, or any of the hundreds of other possi-
ble uses of a computer, and they do not want to
invest the time and effort to learn any new computer
uses.
Leave it Alone

If you are like one of these friends of mine and
are happy with your computer and what you use it
for, and are not interested in any of the new gadgets
or uses, then leave well enough alone. Don’t spend
your time and money for something that you don’t
need.

On the other hand, suppose that you have
become interested in digital photography because
your family gave you an expensive digital camera
for your birthday. The camera probably uses special
software and needs a computer with certain mini-
mum specifications for its use. Many of these cam-
eras require that the computer have a USB port and
a certain operating system. The camera usually
comes with software for editing the photos and you
may want to learn how to send some of your pictures
to friends and relatives. You may begin to think
about how to organize and archive the photos, and
maybe store them on CDs using a CD-R/RW drive.
So you may be now getting involved in new hard-
ware and software. You may consider buying a new
printer that is especially designed to print photos,
with beautiful colors and large sizes, with excellent
resolution and quality.
The Fun Begins

So now the fun begins. Do you need a complete
new computer, or just some new hardware parts and
some new software? If you buy a complete new
computer, what happens to all the data, files,
programs, etc. that you are used to using on the old
machine? What will you do with the old computer?
Will you keep it or give to another member of the
family, perhaps give it to one of the kids? A kid
probably would like to have it to play games, but
that usually requires buying and installing the
game software, and games often require very power-
ful computers. More decisions to make....

Maybe you will consider upgrading the computer
hardware and software instead of giving it away.
How do you do this? How much will it cost? How
reliable will it be? Who will do it for you? Will it be
guaranteed? Many users find it confusing to make

decisions about upgrading the hardware and soft-
ware. There are so many things to consider.

Should you get a larger and faster hard drive?
How much more RAM should you add? Do you need
a faster CPU? Is the motherboard compatible or
should it be changed also? Should you add a
CD-R/RW drive? What about the operating system
and the other software? Some users find it so confus-
ing to make all these decisions about upgrading the
hardware and software of their present computer
that they just go out and buy a new one.

But even buying a new computer requires mak-
ing many decisions. Should it be a desktop, tower or
laptop? How about a new flat-panel monitor? How
much should you spend? How much RAM? What
brand of manufacturer? How long is the warranty?
Do you get in-home repair service? Do you want a
wireless keyboard and mouse? Which software
programs and games should be included?

So, do you need a new computer? It is up to you!
Copyright © Roland B. Herman 2002 and updated July 8,

2003. All rights reserved and published with permission. Dr.
Herman is a member of the Westchester PC Users Group and
a contributor to The Westchester PC News, a WPCUG publica-
tion.

Society News
Program Meeting

March 9, 2004
by Jan Rothfuss

Helps Half Hour led by: Bill Statt
Q: While surfing the Internet he gets a pop-up
advertisement asking him to register for “Repair
Pro.”
A: Would not trust a pop-up request. Download .com
site has similar software that you can request. JV
Powertools is a good registry cleanup. Free at major-
geeks .com web site. Registry Mechanic is also good.
Q: WS/FTP goes to web site, reads it, but will not
generate the listing. Appears after an install of his
wireless router. Uses Earthlink. 
A: Perhaps needs to look at TCP/IP to automatically
the IP address. Under settings, enable everything
back to automatic settings.
Q: What can I do about my email address being
hijacked. Email are bouncing back with his Hotmail
address saying undeliverable. User name appears to
be legitimate.
A: Someone you know has a virus and it has picked
your address as the sending email. Another is that
an account is ‘hijacked’ and then used by a spammer
. Best to change your password so that the originator
can no longer use it. Suggested to contact Hotmail,
too. 
NOTE: Remember: Never open an attachment
unless you are expecting one. Verify with the sender
first. The virus uses good addresses so beware as the
email may look legitimate. Virus software updates
on Wednesdays - new viruses show up within hours.
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Be sure to keep software updated. Will need to buy
another license after 3 months to one year as it
expires.
NOTE One member sent “Thank You”: reported that
Arpad and Dan helped her to work on a computer
problem. Solution — now has a new computer!
Q: How does new Road Runner virus protection
work? Also comes with e a firewall and a spammer
killer. 
A: Cannot run two sets so you need to remove other
anti-virus software. Will still want to use the hard-
ware router’s firewall plus a software firewall such
as ZoneAlarm. 
Q: I have a computer that I use to run videos on but
at times it begins to stutter. Win 98 SE. Has dis-
abled background programs but still occurs. Has
defragged his hard drive. Fans and heat seem fine.
A: Could try to reinstall the video drivers.
Business Meeting:
Led by Arpad Kovacs

See Steve to be on the nominating Committee
Next month’s meeting we will have a copy of

Windows XP Professional ($300). Special tickets will
be sold. The May meeting program will be to install
Linux and then a drawing for the computer.

Welcome to our new software chair – Tom
Thompson. He is taking suggestions for specific
software requests. 

The program on 3D photography presented by
David Boyer and Bill Davis was very interesting and
well received.

New Users Notes
by John McMillan

O
nly six people attended the March New Users
Group but the discussion was as lively as
usual. A Windows 98 user had trouble when
he used the start menu to get to favorites. It

often took 4 or 5 tries to get to the requested site.
Bill Statt recommended clicking on the Internet
Explorer icon (a blue e) and then clicking Favorites
on the menu bar and selecting a desired site. If it
consistently comes up the 1st time, then the linkage
is the probably the culprit. Otherwise the problem is
likely in Internet Explorer browser itself. 

When the user also mentioned that the computer
was slowing down, Bill asked if cookies had ever
been cleared. Temporary Internet files will also
build up, occupying more disk space and increasing
search time. The user had not cleaned up anything
recently. He had run McAfee but did not find any
viruses. Ad-aware (a program that examines files for
spyware) identified some suspicious programs, but
he had taken no action. Spyware, software that
tracks keystrokes or Internet activity, slows the
machine down while it accumulates information to
send back to its originator. Bill mentioned that old
versions of Ad-aware could not be updated but

should be deleted before downloading free version
6.0, that includes newer search criteria. 

Spy-bot is another free program that compli-
ments Ad Aware because it searches deeper in the
registry for spyware connections. Another user
pointed out that frequently “dancing the security
tango” is Nick Francesco’s repeated recommenda-
tion. This is another way of saying update the virus
and spyware definitions; run the antivirus, Ad-
aware, and Spybot scans; and run McAfee’s Stinger
which checks for specific viruses that attack anti
virus programs. Stinger can be downloaded at no
cost and should be run with the others at least
weekly. 

Users were cautioned that updates to Anti-virus
programs included with the purchase of a computer
are sometimes limited so a contract may need to be
established for future definition updates. Remember
that the definitions can be sadly out of date depend-
ing on the elapsed time since the software was
loaded into the computer or the shelf life of a pur-
chased version. On the topic of Antivirus programs,
Bill mentioned going to GriSoft.com to download a
free version of AVG 6.0 but emphasized that multi-
ple anti virus programs cannot work together so
existing Norton’s or McAfee's programs should be
uninstalled first. AOL checks e-mail for viruses
before sending them to your computer but that does
not protect you from malicious web sites or trans-
ferred disks. 

Road Runner also offers a centralized anti virus,
anti spam package which does not conflict with
software on your machine. A user wondered why he
was getting notices from Microsoft alerting him to
critical updates. Bill said that critical updates are for
security holes in the Windows operating system but
a minimal number (for really big holes) are related
to Windows 98. Most routers include a hardware
firewall but he cited Zone Alarm, a software fire wall
that is a free download from Zone Labs. This is
another excellent security tool because it asks
permission before going out to connect to the web. A
small box lets you bypass checking specific connec-
tions though to my mind this defeats the purpose of
having a fire wall. 

No one was familiar with AOL operations to
address a question about receiving mail that opens
automatically, releasing viruses. Bill did point out
that Microsoft Outlook Express has a preview
feature that should be disabled to prevent mail from
opening before you can take precautions. He sug-
gested checking AOL to see if it had a similar pro-
cess. No matter what service is used, it is a good
policy never to open e-mail attachments unless they
are from someone you know and you expect them. 

Too many viruses hijack addresses from other
peoples machines and use them to proliferate the
virus. Someone asked if there was a single way to
clean up the hard drive. In Windows 98, selecting
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the hard drive in either My Computer or Windows
Explorer and then clicking Properties opens a multi
tabbed window. Clicking the general tab shows how
much space is being used and how much is available
both in bytes and graphically. It also includes a Disk
Clean up button which when pressed opens a multi
tabbed disk cleanup window. The Disk Cleanup tab
shows how much space can be gained by deleting:
temporary Internet files; downloaded program files;
recycle bin contents; temporary files and old scan
disk files in the root folder, (lost file fragments found
when the disk was scanned). A box in front of each
of these file types can be if checked so they will be
deleted when the ok button is clicked. 

The More Options tab which allows Windows
components and unused programs to be deleted
might be a little more dangerous. The Settings tab
gives you the choice of automatic cleanup when disk
space gets low. The Tools tab of the Properties
window tells you how long it has been since you
scanned or defragmented the disk and gives buttons
to initiate each action. There may also be data about
disk backups. Finally the Properties window has a
tab that prevents sharing or lets you set the param-
eters for allowing sharing. 

As an alterative, Bill suggested clicking Start,
then Accessories, then System Tools and looking for
disk clean or disk cleanup. A couple that wanted to
share peripherals and files between computers
running XP and 98, did not know how to use net-
work neighborhood. Files which may be shared are
data files because it is usually illegal to share
programs between machines without having sepa-
rate licenses. Clicking My Computer would show all
components including the drives from another
machine if they are networked. 

When drives from another machine cannot be
seen, there is no network. Bill said to be sure both
machines are turned on and then click the Network
Neighborhood icon of the XP machine. Clicking on
the task "Set up a home or small office network"
opens a Network Setup Wizard that walks people
through the setup process. When that is finished, it
offers to make a floppy disk with all of the network
instructions on it. When that has been done, the
floppy should be inserted in the other computer
where it will network that machine to the XP
computer. A Windows XP user found that icons for
URL's (Uniform Resource Locator) disappeared from
his desktop and wondered why. Bill suggested right
clicking somewhere on the desk top which will bring
up a menu that includes Arrange Icons By. 

Positioning the cursor over that choice opens a
sub menu where he should left click Lock Web Items
on Desktop. This will prevent Web items from being
cleared at the next startup. Web items were not
cleared by Windows 98 when it was closed. The user
mentioned having a Logitech keyboard and optical
mouse on the machine running Windows XP. Press-

ing the center button of the Logitech mouse opened
software that displayed a wheel of favorites on the
monitor. The mouse wheel could then be used to
select a location from the display and initiate that
action. Apparently this software was somehow
disabled leading the user to put the URL's on the
desktop. 

Another Logitech user mentioned finding spy-
ware on the Logitech software disk. When asked
about a 3D accelerator card to improve game perfor-
mance, Bill suggested right clicking My Computer
and then clicking Manage. Clicking Device Manager
in the window that opens would list devices in the
right hand pane and clicking on Display Adaptors
would show what video card was installed. Right
clicking that name opens choices including update
the driver; and properties which opens a multi
tabbed window with additional information includ-
ing a trouble shooting process.

Bill was concerned that installing some older
game might have modified the screen resolution and
3D acceleration. If that were the case the user might
only need to reinstall the video driver from the
original floppy or CD. If the drivers were reinstalled,
Bill recommended going to the manufacturers web
site to check for updates. Since the computer had
been made locally, the maker could be asked what
video card was installed and for a comparison of its
capabilities with others in the marketplace to deter-
mine where gains could be made and at what cost.
Free games may also be a source of spyware so the
computer should be checked, as discussed previously,
both before and after downloading to isolate poten-
tial problems. 

Our next meeting, will be April 6th at the Mon-
roe Developmental Center, 620 Westfall Road. Why
not bring your questions and join us for the all the
fun.

Treasurer’s Report
by Steve Staub

Balance as of 2/17/04 $701.84
ExpensesExpenses
St. Stephens $75.00
Postmaster 50.00
Office Max–paper  107.96
Total $232.96
IncomeIncome
Dues and food $160.75
Sale of printer ribbons  60.00
Total $220.75
Balance as of 3/11/04 $689.63
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The Lighter Side
A computer is like an Old Testament god, with a

lot of rules and no mercy. –Joseph Campbell

A computer lets you make more mistakes faster
than any invention in human history — with the
possible exceptions of handguns and tequila. –Mitch
Ratliffe

All parts should go together without forcing. You
must remember that the parts you are reassembling
were disassembled by you. Therefore, if you can’t get
them together again, there must be a reason. By all
means, do not use a hammer. –IBM Maintenance
Manual, 1925

Computers are useless. They can only give you
answers. –Pablo Picasso

Computers will never take the place of books.
You can’t stand on a floppy disk to reach a high
shelf. –Sam Ewing

Don’t explain computers to laymen. Simpler to
explain sex to virgins. –Robert Heinlein in The Moon
is a Harsh Mistress

Hardware: the parts of a computer that can be
kicked. –Jeff Pesis

It was not so very long ago that people thought
that semiconductors were part-time orchestra
leaders and microchips were very small snack foods.
–Geraldine Ferraro

Man is the best computer we can put aboard a
spacecraft . . . and the only one that can be mass
produced with unskilled labor. –Wernher von Braun

No computer has ever been designed that is ever
aware of what it’s doing; but most of the time, we
aren’t either. –Marvin Minsky

One thing a computer can do that most humans
can’t is be sealed up in a cardboard box and sit in a
warehouse. –Jack Handey

There is only one satisfying way to boot a com-
puter. –J.H.Goldfuss

They have computers, and they may have other
weapons of mass destruction. –Janet Reno

The most likely way for the world to be de-
stroyed, most experts agree, is by accident. That’s
where we come in; we're computer professionals. We
cause accidents. –Nathaniel Borenstein

To err is human and to blame it on a computer is
even more so. –Robert Orben

Usenet is like a herd of performing elephants
with diarrhea — massive, difficult to redirect,
awe-inspiring, entertaining, and a source of
mind-boggling amounts of excrement when you least
expect it. –Gene Spafford

Wow! They’ve got the Internet on computers
now! –Homer Simpson 


